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Internet Reporting 

Overview 

Transit agencies must use the National Transit Database (NTD) Internet reporting system to provide their data via reports to 
the Federal Transit Administration (FTA). NTD Internet reporting is the online means for transit agencies to enter, save, 
review and revise data, and submit reports. It provides for timely and accurate reporting as all tasks and requirements for the 
NTD can be fulfilled via this system. 

This section provides Internet reporting information for the NTD Annual report.  

What Has Changed from Prior Years 
NTD application has been updated with a number of Application Security Enhancements.  These enhancements are being 
undertaken in accordance with new Department of Transportation-wide and Federal Government-wide standards to ensure 
the integrity of all data in government systems, such as the National Transit Database.   
 
Please note the new password requirements for password length and complexity, as well as that the password expiration 
period has also changed from 90 to 60 days.  Moreover, please note that a new 60-day account inactivity feature will lock 
accounts that have not been used at least once in a 60 day period.   Accounts that become “locked” will be able to be 
unlocked through an automatic web-based process, which will also prompt you to choose a new password.       
 
New Password requirements are as follows 
• Password length: Must be at least 12 characters and not more than 20 characters. 
• Complexity: 3 out of 4 – Lower case, Upper case, Numbers, Special Characters. 
• Password History: Password must be different from 10 previous passwords and must be different from any password 

used in the last 6 months. 
 
Maximum Password Age 
• 60 Day Password Expiration Period. 
 
Account Inactivity 
• Your account is locked if you do not login during a 60 day period. 

Internet Reporting System Security 
Many measures have been taken to ensure that all data entered into the Internet reporting system are safe and available 
only to those with proper access. The NTD servers and network are secured behind a firewall. The website is password 
protected. Additionally, multiple server and database protection layers protect the database files. 
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Detailed Instructions 

The preparation and submission of the Annual Report is a simple process that involves interacting with the online Internet 
reporting system. The detailed instructions describe this process in the order that most reporters will proceed and cover the 
following topics: 
• Accessing Internet reporting 
• NTD Reporting Structure 
• Home: Annual Report Home Page and Program Structure 
• Sys Admin: Changing Your Password 
• Monthly Ridership: Reporting Ridership Data 
• Safety & Security: Reporting Incident Data 
• Help: Obtaining More Information 
• Annual: Reporting Annual Data  
• Notes: Providing Additional Information 
• Issues: Validating Annual Data 
• Reports: Accessing Reports to Help Report Annual Data 
• e-File: Sending Declarations, Requests, and Other Communication 
• Communications: Viewing History of Communications with NTD. 

Accessing Internet Reporting 
Internet reporting is accessed from the NTD Homepage. 

To access Internet reporting:  
• Connect to the Internet via your Internet service provider (ISP) 
• Verify your Internet browser settings 
• Access the Internet reporting website at www.ntdprogram.gov 
• Access your transit agency’s NTD report via the Internet Reporting Login link. 

Connecting to the Internet 
You should use your ISP to connect to the Internet. Internet reporting requires a web browser that is at least a 6.x version 
(e.g., Internet Explorer 6.0). 

If you don’t have the latest version of the browser, go to Microsoft.com to download the latest version free of charge. 

Browsers such as Firefox, Mozilla and Chrome are not fully compatible with the Internet Reporting system. You should use 
Internet Explorer for reporting. 

Verifying Your Internet Browser Settings 
You should verify that your browser is set to check for newer versions of stored pages with each visit to the website. 

In Internet Explorer, this is done by accessing Tools / Internet Options / General / Temporary Internet Files Settings / Every 
Visit to Page. 
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The National Transit Database Website 

 
 

The NTD Homepage offers the following information and data for reporters and others interested in the NTD: 
• Internet Reporting Login link. 
• What is the NTD? An overview of the NTD program, milestones in transit history, how to obtain an NTD ID number, and 

an overview of the NTD reporting forms. 
Reporting Manuals 
• Annual Reporting: Access to HTML and PDF versions of the current Annual Reporting Manual, an overview of 

reporting changes and highlights, reporting manual archives, etc. 
• Monthly Reporting: Access to HTML and PDF versions of the current Monthly Reporting Manual, an overview of the 

reporting changes and highlights, reporting manual archives, etc. 
• Safety and Security Reporting: Access to HTML and PDF versions of the current Safety and Security Reporting 

Manual, Newsletters, Safety and Security frequently asked questions (FAQ), an overview of reporting changes and 
highlights, reporting manual archives, etc. 

• Rural Reporting: Access to HTML and PDF versions of the current Rural Reporting Manual and Excel spreadsheets, 
an overview of reporting changes and highlights, reporting manual archives, etc. 

• Sampling: Access to the PDF File of the Sampling Manual, HTML version of the glossary, Excel spreadsheets of a 
Sampling Template and a Sampling Template with data. 

• Small Systems Waiver Manual:  Access to HTML and PDF versions of the current Small Systems Waiver 
Reporting Manual, an overview of reporting changes and highlights, reporting manual archives, etc. 

Data, Publications and Reference Materials 
• NTD Glossary: HTML version of the NTD Glossary of transit terms. 
• NTD Reference Materials: NTD reference materials such as the Uniform System of Accounts, FTA Circulars and 

Federal Register Notices. 
• Access NTD Data: HTML and downloadable PDF publications, including the Data Tables (also available as MS Excel 

self executable files), Profiles, National Transit Summaries and Trends, as well as Annual, Monthly and Historical 
databases (MS Excel self executable files) and other data products. 

NTD Resources 
• FTA / NTD Presentations, Announcements and Updates: FTA / NTD presentations, new and useful information, 

interim updates to reporting requirements, etc. 
• NTD Feedback: The mailing address, telephone number and fax number for the NTD Project site as well as an 

opportunity to provide comments or suggestions regarding the NTD Program.  
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• Seminars and Training: NTD Reporting Seminars and In-house Training information and registration. 
• Transit Agency Listing by Region and External Links: Contact information for transit agencies reporting to the NTD 

listed by UZA and State. Links to:  
• Federal Transit Administration (FTA) 
• FTA Safety and Security Office 
• U. S. Department of Transportation (USDOT) 
• National Transit Library 
• American Public Transportation Association (APTA) 
• Bureau of Transportation Statistics (BTS) 
• Accessibility. 

 
Accessing the NTD Report  

Clicking the Internet Reporting Login link will open the Internet Reporting Login page. You must enter your user name and 
password to gain access to NTD Report Home.  

 
 Levels of Access 

Internet reporting provides four levels of access to the Annual Report with the following rights  
1. CEO access: Edit forms (data entry), approve Chief Executive Officer (CEO) Certification form (D-10) and submit report 
2. Contact Person access: Edit forms (data entry) and submit report (administrator) 
3. Editor access: Edit forms (data entry), cannot submit report 
4. Viewer access: Viewing rights only for forms, issues, notes and correspondence with no rights to edit or submit. 

User Names and Password 
The system access level is determined by the user name. The first three characters of the user name define the access level 
and the last four digits represent the transit agency’s NTD ID. There are four types of user names corresponding to the four 
access levels available within the Annual Report: 
1. CEO — CEO#### 
2. Contact person — NTD#### 
3. Editor — EDT#### 
4. Viewer — VWR####. 

Each transit agency is e-mailed this set of user names with a password for each. Transit agencies determine access within 
their organizations and distribute user names and passwords accordingly. 

A user can change his / her password at any time. Refer to Sys Admin: Changing Your Password for additional information 
on this topic. Users should be aware that passwords must be changed every sixty days. 
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The CEO and NTD contact person use the same password for all reporting modules. The CEO and NTD contact 
person may access all reporting modules (Annual, Monthly and Safety and Security) from the Home tab. 

 

Home: Annual Report Home Page and Program Structure  

 
After completing the Login process you will be taken to the Annual report Home page. You must click the Home tab near 
the top of any screen to return to the Home tab from another area. 

When accessing the Home tab, please take note of the Announcements section. There you will find a listing of FTA 
announcements.  

NTD Reporting Structure 
The Annual Report module has the following tabs: 
• Home: The starting point when entering the NTD report. It displays the transit agency’s NTD analyst information and 

any project related announcements. 
• e-File: A listing of all declarations, waivers, other general correspondence and current year report submission stages. 

This screen allows a transit agency to view the text of existing declarations, waivers, fixed guideway requests and 
general correspondence, and to add documents using the file attachment feature.  

• Annual: A listing of the reporting forms necessary to complete your NTD Annual report. It is from this screen that the 
transit agency submits the NTD Annual report. The Submit Report button appears at the bottom of the Forms 
Summary screen after the CEO approves the CEO Certification form (D-10).  

• Monthly: This screen provides access to the NTD Monthly reporting forms for editing and submitting your report to FTA. 
Form-by-form instructions and reporting details for the Monthly Module are included in the NTD Monthly Reporting 
Manual. The NTD contact person is responsible for submitting Monthly data to NTD. 

• Safety and Security: This screen provides access to the Safety and Security Module forms for editing and submitting 
your report to FTA. Form-by-form instructions and reporting details for the Safety and Security Module are included in 
the Safety and Security Reporting Manual. 

• Notes: Displays all the Form Notes added to the transit agency’s Annual report. Internet reporting allows the transit 
agency to create Form Notes to provide additional information applicable to the overall form. 

• Issues: Displays all the Issues generated for the transit agency’s Annual report. Issues highlight potential problems with 
specific data items (specific data which fall out of a typical range of values) and are generated each time the transit 
agency saves a form or submits the NTD Annual report. To correct an Issue, the transit agency may either change the 
data item on the appropriate form or attach a Comment to the individual Issue and explain. You should use this screen 
to review the Issues for entire report (form by form) prior to submitting your NTD Annual report.  

• Reports: Print and export reports (Notes and Issues, Service Characteristics – Time Series, Key Performance 
Indicators, and Revenue Vehicle Inventory – Prior Year’s History, and Operating Expenses by Function and Hourly 
Wages – Prior Year’s History). All reports have been developed to allow you to print each form or report without altering 
print settings to fit a form on the page. The reports listed will vary depending on your access level. 

• Communications: This screen provides a record of the report submissions the agency has made to NTD, including any 
comments from the agency and the review status of the report. 
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• Sys Admin: Change NTD passwords – CEO, NTD Contact Person, Editor and Viewer. You may only change your own 
password. Should you need assistance, contact your NTD analyst. 

• Help: Online version of the Reporting Manual.  

Annual: Reporting Annual Data 

 
Click on the Annual tab to open the Forms Summary screen. The Forms Summary screen lists the 2012  NTD modules 
and provides links to the specific forms, within each module, that your transit agency is required to complete. 

Initially, the Forms Summary screen only provides access to two forms within the Basic Information Module: 
1. Identification form (B-10), and  
2. Contact form (B-20). 

After you review, complete and save the B-10 form, Internet reporting automatically generates the forms necessary to 
complete the NTD Annual report.  

The forms generated are dependent upon: 1) the number of vehicles operated in annual maximum service (VOMS) by mode 
and TOS, 2) the UZA size, 3) whether a Small Systems  Waiver request has been indicated, 4) whether the seller in a 
purchased transportation agreement is filing a separate NTD Annual report and 5) whether a Grants (Planning or Capital) 
Waiver request was indicated. All form-by-form instructions and reporting details are provided in the form specific sections of 
this manual.)  

After the B-10 form has been saved the Forms Summary screen provides access to forms that your transit agency is 
required to complete. The mode and TOS, the update user and update date, and the number of issues for each form are 
also displayed. 

The Forms Summary screen also provides the means to add a new Contractual Relationship form (B-30). Internet reporting 
automatically generates a B-30 form for each purchased transportation agreement, (i.e., contracts) that existed in the transit 
agency’s previous year report if at least one mode designated on the prior year’s form is also reported on the B-10 for the 
current reporting year.  

If you want to add a new Contractual Relationship form (B-30) for a new contract, you click the Add Form button at the 
bottom of the Forms Summary screen and select B-30 from the drop-down menu. 

Printing a Form Report from a Form Screen 
Click on the Print button at the bottom of the Form screen to display the report in Adobe Acrobat Viewer; then click the 

Print button  in the upper left corner of the viewer and click the Okay button on the resulting Print window. 

Submitting Your Report 
To submit your report to the NTD, upon completing the required NTD forms, you should return to the Annual tab, scroll to 
the bottom of the page, and click the Submit Report button. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G524
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G266
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G503
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Monthly: Reporting Ridership Data 

 
 
Click on the Monthly tab to open the Monthly screen. This screen provides access to the Monthly Module forms for editing 
and submitting your report to FTA.  

Form-by-form instructions and reporting details for the Monthly Module are included in the Monthly Reporting Manual. 

Safety and Security: Providing Incident Data 

 
 
Click on the Safety and Security tab to open the Safety and Security screen. This screen provides access to the Safety 
and Security Module forms for editing and submitting your reports to FTA.  

Form-by-form instructions and reporting details for the Safety and Security Module are included in the Safety and Security 
Reporting Manual. 

Notes: Providing Additional Information 

 
 
Click on the Notes tab to open the Notes Summary screen. Internet reporting allows the transit agency to create a Form 
Note for information applicable to the overall form. 

Creating a Form Note 
To create a form note, you should click on the Add Form Note link at the top right of the form you are editing or viewing. 
Internet reporting will take you to the Form Notes screen for the specific form. Internet reporting pre-fills the mode and TOS 
(if applicable) for which the note is created. You must complete the note comment. 
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To save a form note, click on the Save button at the bottom of the screen. To return to the form being edited without saving 
the note, click on the Cancel button. 

Reviewing Form Notes 
Click on the Form Notes tab to view the Form Notes screen. You can review the form notes associated with a specific form 
or all form notes for the report. While working in a form click on the Form Notes tab to display the Form Notes screen for 
the form. The form name, mode and TOS will be displayed just beneath the tabs. 

You also can review form notes associated with prior submissions for the current Report Year (i.e., 2012) and prior Report 
Years (i.e., 2010 and earlier). To view current or prior year’s form notes, click on the Report drop-down menu located above 
the tab line, and select the year and report stage (original, working data, revision, closeout) that you wish to view. 

Editing Notes 
While you are in the Working Data report stage, you can edit a form note after it has been created by clicking on the Edit 
Note link in the far right column on the Form Notes screen. Once the NTD Annual report is submitted the notes are frozen 
and cannot be edited. Notes can only be edited while in the report status is Working Data which is displayed at the top of 
screen in the Report menu. 

Notes are frozen with each submission. If the report is sent back to the transit agency and notes are reviewed or 
added, the previously submitted notes will not be affected. 

Printing Form Notes 
You can print all form notes from the Reports tab by clicking the Notes and Issues Report link. 

Issues: Validating Data 

 
 

You access the Issues screen by clicking the Issues tab. This screen highlights potential problems with specific data items 
identified through the NTD validation process. 

The NTD validation process ensures that NTD reporting requirements are met and that the reported data fall into reasonable 
ranges and make sense. Validation checks include: 
• Range checks for typical values found among transit agencies with similar operating characteristics 
• Logic checks between data items on different NTD forms 
• Time series checks against previous years’ data to identify data that have changed significantly. 

NTD validation is an interactive, iterative process with two alternating phases: 
1. Pre-submission (working data report stage) validation — automatic review prior to submission of the NTD Annual report 
2. Post-submission (the original submission or a revision report stage) validation — review by your assigned NTD 

validation analyst after submission of the NTD Annual report. 

In support of the NTD validation process, an NTD validation analyst is assigned to each transit agency. NTD validation 
analysts are available to assist transit agency personnel and may be contacted at the NTD Project Office. Direct contact 
information for each validation analyst is available from the Home tab in the Announcements section (refer to the NTD 
Contact Information) Refer exhibit under Where to Report in the Introduction section of this manual for general NTD contact 
information (mailing addresses, hours of operation, etc.). 

Sys Admin: Changing Your Password 
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The Sys Admin screen provides the ability to change your NTD password.  
All passwords expire every sixty days. You can change your password at anytime on the Sys Admin screen by specifying 
your current and new password. To be valid, a password must contain at least 3 out of 4 of the following character types: 
Upper case, Lower Case, Numbers, or Special Characters. Password cannot contain spaces, and must be at least 12 
characters and not more than 20 characters.. Passwords are case-sensitive. If you do not change your password within the 
sixty-day period, you will be forced to change your password when you first access the system once the sixty-day period has 
expired. It must be different from 10 previous passwords and must be different from any password used in last 6 months. 
The screen is similar to the one available on the Sys Admin screen and the same password rules apply.  

Help: Obtaining More Information 

 
Click on the Help tab to display the Help screen. The Help screen provides access to the 2012 Annual Reporting Manual for 
additional help in completing the NTD Annual report forms. The Help screen displays the table of contents for the Reporting 
Manual with links to each section of the manual. 

Pre-Submission Validation 
Internet reporting automatically performs issue checks after a form is saved. The issue checks help you assess the 
completeness and reasonableness of your data prior to submission to FTA.  

Since some issues checks are performed using data items from more than one form, it is best to respond to 
issues after all forms are completed. 

Issues are classified by issue type according to severity and action required in order to submit the NTD Annual report: 
• C (Critical): The transit agency is not able to submit the NTD Annual report until all Critical issues are corrected. 
• I (Important): The transit agency is not able to submit the NTD Annual report until all Important issues are corrected or 

explained through a Comment associated to the issue. Comments are added to a particular issue via the Add 
Comments link located adjacent to each issue on the Issues Summary page. 

The Forms Summary screen identifies the number of issues by each type for each form. You can access the Forms 
Summary screen by clicking on the Issues tab from the Annual report Home page. 

You should also review the issues for a specific form. You can access the complete listing of issues for the specific form by 
clicking on the Issues tab while viewing the form.  

You also can review issues associated with prior submissions for the current Report Year (i.e., 2010) and prior Report Years 
(i.e., 2009 and earlier). To view current or prior year’s issues, click on the Report drop-down menu located above the tab 
line, and select the year and report stage (original, working data, revision, closeout) that you wish to view. 

Prior to the original submission, issues are deleted as you correct the data and resave the forms. Important issues that 
remain when the NTD Annual report is submitted will continue to be available for review on the Issues tab. Any corrections 
or explanations subsequent to the original submission will be recorded and are available for review by you and the NTD staff. 

As with Form Notes, the issues are frozen with each submission, and cannot be altered until the report is 
returned. 

uyen.thai
Line

uyen.thai
Line

uyen.thai
Line

uyen.thai
Line



2012 Annual Reporting Manual 

28 — Internet reporting  

Post-Submission Validation by NTD Analysts 
After the transit agency submits the NTD Annual report, the report is frozen as the Original Submission report stage. At this 
point in the process, the data cannot be edited by the transit agency. This is also true of each re-submission (revision). 

The issues undergo a series of reviews by NTD staff during which the issue status may be changed. At each stage, you 
should revise forms as necessary, review issues, respond to the issues, save and re-submit the report. The status of an 
issue is not considered to be final until the Closeout letter has been approved.  

 

Exhibit 7 — Issue Status 
Active Issues that require review by the transit agency. 
Active with Comments After a transit agency reviews and adds comments to an Active issue, 
the issue is assigned an Active with Comments status. 
Questionable Issues may be included in a Closeout with Issues letter and pertinent 
data is indicated as Questionable in publications. 
Under Review NTD validation analysts recommend that these issues have been 
sufficiently addressed by the transit agency. 
Reviewed  Recommendation to FTA that no further action is necessary by the 
transit agency. 
Fixed Issues corrected by the transit agency by revising those data item(s) 
which caused the issue to be generated originally. No further action is required by the transit agency for these issues. 

 

As your report is moved through the validation process, the NTD validation analyst reviews the reported data and 
recommends that FTA either accept your transit agency’s issue comments or designates the issue as Active for further 
review by your agency. Upon completion of this review, the NTD validation analyst makes the report available to your agency 
as Working Data. When this is done, you can edit the report or provide more information. Review by both the transit agency 
(in working data stage) and the NTD validation analyst (in revision stages) continues until all issues have been designated as 
Fixed, Questionable or Reviewed. The report will then move to the Closeout report stage. 

Closeout: Completion of Issue Validation 
The validation process ends with the generation of the Closeout letter for a transit agency:  
• A Closeout without Issues letter is generated if all issues have either been Fixed or Reviewed 
• A Closeout with Issues letter is generated if there are Questionable or remaining issues at closeout. 

You can access the letter from the e-File tab. 

Reports: Accessing Reports to Help Report Annual Data  

 
Click on the Reports tab to display the Reports screen. This screen provides access to several reports available to assist 
you in preparing your NTD Annual report. 

Please refer to the section on Printing for instructions on viewing, printing and exporting a report. 
To open a report, you should click the corresponding link on the Reports screen and the report will open Adobe Acrobat 

Viewer. You can print the report by clicking the Print button  in the upper left corner of the viewer and click the Okay 
button on the resulting Print window. 

You can also review selected reports associated with prior submissions for the current Report Year (i.e., 2012) and prior 
Report Years i.e., 2010 and earlier). To view current or prior year’s reports, click on the Report drop-down menu located 
above the tab line, and select the year and report stage (original, working data, revision,  and closeout) that you wish to view. 

The following report links are available on the Reports screen:  
• FFA Data Distribution by UZA Report 
• All Form Notes and Issues Report 
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• Service Characteristics – Five-Year History 
• Performance Indicators – Five-Year History 
• Revenue Vehicle Inventory – Prior Year’s History 
• Operating Expenses by Function and Hourly Wages – Prior Year’s History 
• Key Performance Indicators – Average Trip Length – Prior Year’s History. 

All Form Notes and Issues Report 
Click on the All Form Notes and Issues Report link to print all of the form notes and issues associated with the NTD 
Annual report as viewed on the Form Notes screen or Issues tab. 

Additional Reports Available from the Reports Tab 
For all of the following reports, the default will be a five-year history. However, the user can change the report to show 
additional years’ history using the Report drop-down located above the tab line. 

Service Characteristics 

Click on the Service Characteristics link to view the report. This report provides the number of VOMS, the vehicle revenue 
hours (VRH) and miles VRM), the deadhead hours and miles, the total actual hours and miles, the number of unlinked 
passenger trips (UPT), the number of passenger miles traveled (PMT) and the total operating expense (OE) for each mode 
and TOS operated for the current reporting year and four years prior with the percentage of variation from year to year. 

Key Performance Indicators 

Click on the Performance Characteristics link to view the report. This report provides the trip length, load factor, revenue 
speed, deadhead speed, cost per hour, cost per mile and cost per passenger for each mode and TOS operated for the 
current reporting year and four years prior with the percentage of variation from year to year. 

Revenue Vehicle Inventory – Prior Year’s History 

Click on the Revenue Vehicle Inventory – Prior Year’s History link to view the report. This report provides the total fleet, 
active fleet, ADA fleet, and average fleet age for each mode and TOS operated for the current reporting year and four years 
prior with the percentage of variation from year to year. 

Operating Expenses by Function and Hourly Wages – Prior Year’s History 

Click on the Operating Expenses by Function and Hourly Wages – Prior Year’s History link to view the report. This 
report provides the vehicle operations expense, vehicle maintenance expense, non-vehicle maintenance expense, general 
administration expense, vehicle operations hourly wage rate, vehicle maintenance hourly wage rate, non-vehicle 
maintenance hourly wage rate and general administration hourly wage rate for each mode and TOS operated for the current 
reporting year and four years prior with the percentage of variation from year to year. 

Key Performance Indicators – Average Trip Length – Prior Year’s History 

Click on the Key Performance Indicators – Average Trip Length – Prior Year’s History link to view the report. This report 
provides the average trip length by average weekday service, average Saturday service, average Sunday service and 
annual total data for the current report year and prior years with the percentage of variation from year to year. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G518
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G518
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G519
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G110
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G14
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G19
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G502
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G502
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G351
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G302
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e-File: Sending Declarations, Requests, and Other Communication  

 
 

The e-File tab is located between the Home tab and the Annual tab. The e-File tab is a centralized area in which to 
compose, organize and track agency correspondence with the NTD program. 

All correspondence, waivers and other requests, as well as the Independent Auditor Statements are attached and submitted 
using the e-File tab and using the CEO level log-in to submit these correspondences. Only the CEO log-in can submit a 
correspondence.  The e-File tab provides the following organization and tracking features:  
• General correspondence is organized by sender: 

• Reporting agency 
• NTD program staff. 

• Once generated, correspondence is stored on the e-File Summary screen without the need for external files. 
• The status or phase (approved, denied, etc.) of the process for each correspondence item is indicated under the Status 

heading by correspondence type.  

E-mail responses are sent to the transit agency following requests through the e-File system. Examples of letters sent from 
FTA to transit agencies are: 
• Closeout correspondence 
• Late Letter correspondence 
• Late Response correspondence.  
The following sections describe: 
• e-File tracking 
• e-File composing: Extensions, Waivers, Other Agency Requests and Declarations 
• NTD Process after e-File Submission 
• e-File at the End of the Year 

e-File Tracking  
The e-File Summary screen provides a snapshot of the status of the NTD Annual report:  
• Report stage 
• Waivers 
• Declarations 
• Other agency requests 
• Outgoing NTD Correspondence. 
Report Stage 

This section lists the dates that the original report submission and each subsequent revision were sent to NTD and returned 
to the transit agency. Most of the information listed pertains to the current report year. However, some correspondence or 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G393
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G111
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G111
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G310
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Add Declaration Type menu 
selection: 
Independent Auditor Statement for 
Financial Data (IAS – FD) 
Independent Auditor Statement for 
Federal Funding Allocation (IAS-
FFA) 

requests may pertain to future years. These items will be displayed indicating the future report year. In most cases, 
correspondence spans two report years. You may now select up to two report years for the same request. 

To view prior years’ e-File information, you should use the Report drop-down menu, located above the tab line, to select the 
year you wish to view. Note that e-File information is not available prior to RY 2002. 

To add correspondence for prior years’ e-File information, you should click the Add Correspondence button on the current 
year’s e-File Summary screen. You then select the year for which you wish to add correspondence from the Add 
Correspondence screen.  

Waivers 

This section contains the correspondence for any waiver requests as well as their current status. Waivers include: 
 

• Data 
• Financial statement 
• Reporting 
• Passenger miles traveled sampling 
• Planning and Capital Grants 

Declarations 

This contains the declarations submitted to NTD via the e-File and their current status (Not Submitted, Received, Cancelled, 
Approved, Approved with Issues, and Denied). The declarations are: 
• Independent Auditor Statement for Financial Data (IAS-FD) 
• Independent Auditor Statement for Federal Funding Allocation (IAS-FFA). 
• Safety and Security CEO Certification 

Though not required, FTA strongly encourages each transit agency to attach a copy of their IAS–FFA to the e-
File. 

See both the Introduction and Declarations sections of this manual for guidance and clarification of which Independent 
Auditor Statements are required and when. 

Other Agency Requests 

All other correspondence between the transit agency and NTD is contained in Other Agency Requests. Examples of this 
type of correspondence are: 
• Request to file a consolidated report 
• Extension requests  
• Change in transit agency fiscal year 
• New fixed guideway (FG) requests 
• New ID request 
• New ID request response 
• Clarification of a reporting requirement (Other). 

Outgoing NTD Correspondence 

All Closeout letters, Failure to Report Warning (for, Late Report, Incomplete Report and Failure to Respond) letters and any 
official correspondence for clarification from FTA are sent to transit agencies that do not comply with NTD reporting 
requirements. Electronic copies of the letters are submitted to transit agencies via the e-File 
tab. 

e-File Composing: Waivers, Other Agency Requests and Declarations 
Waivers and Other Agency Requests are all considered correspondence. The following 
discusses each type of request and describes the steps taken to create, edit and submit 
them. Some declarations are also submitted in the e-File. 
Adding a Request or Declaration  

On the e-File Summary screen buttons are available for each type of correspondence request and declaration (i.e. waivers, 
declarations and other agency requests). You should click the appropriate button to initiate a specific request and display the 
Add Correspondence / File screen. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G277
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G277
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G106
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G106
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G148
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G148
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G395
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G395
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G350
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G208
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Other Agency Request Type 
menu selection: 
Consolidation Request 
Extension Request 
FY Change Request 

    

Once a request or declaration is initiated, you will be directed to the Add Correspondence / File screen. On this screen 
there are several specific pieces of information that are required, including: 
• Report Year: This is a required field that identifies the report year for which the correspondence is made. In most cases, 

you will be adding correspondence that will be applicable to the current report year. However, you may want to create 
correspondence pertaining to a future report year. Both current and future report year correspondence will appear on the 
e-File Summary screen by report year. 

• Type: This is a required field. You should use the drop-down menus to identify the type of correspondence to be 
submitted. For example, if you arrived at this screen by clicking the Add Waiver button, the drop-down menu will display 
the five waiver types. If you clicked the Add Declaration button, the three declaration types will be listed.  

Writing or Attaching a Document 

You have the choice to either insert text or attach a document to send correspondence to the NTD. You should select Insert 
Text to generate a field where you can type your agency’s request. There is also the option to attach a more formal request 
by using the Letter Attachment option and submitting the request to NTD following the guidelines below. 

Editing a Request 

Appropriate transit agency personnel (based on user rights) can edit the request at any time after the request is saved and 
prior to submission. To edit the request, you should click on the link to the file you wish to edit (Data Waiver). The file will 
open and you can edit the content as necessary. However, Internet reporting will not let you edit several of the fields used to 
identify the specific request. 

Attaching Correspondence 

Other types of correspondence may also be attached under the Other Agency 
Requests heading on the e-File tab. To attach the written request select the Letter 
Attachment radio button, then select the Browse button. A Windows Dialog box 

will appear. The appearance of the window may be different based on the 
operating system (Windows NT, 2000, 95/98, Apple Mac, etc.) being used. 
Navigate to the directory in which your file is stored and click Open. The file 
name will appear in the text area to the left of the Browse button. 

Saving Correspondence 

The final step in creating correspondence (waiver, declaration or other 
agency request) is to Save and or Submit the request or declaration by 
using one of the three buttons at the bottom of the screen. 

Depending on your assigned level of access, you can perform certain tasks 
within the system. While certain users can create, save, and submit 
requests, others may only be able to create and save or simply view the request. This type of role-based security allows 
Internet reporting to verify that the appropriate people are making the necessary requests. Based on a user’s role, they will 
see a Cancel, Save and or Submit button. For example: 
1. The Cancel button is available to all users. Cancel simply exits the form and no 

changes are saved.  
2. The Save button is available to those users with CEO, NTD and EDT 

passwords. Once data are entered, the request may be saved. Once saved, the 
request is stored and can be reviewed and edited as often as necessary prior to 
submitting the report to NTD. 

3. The Submit button is limited to the CEO. 

Once the request is saved or submitted, you are returned to the e-File Summary 
screen. The e-File Summary screen will display the request under the appropriate 
heading, followed by the identifying subject line, the year for which the request is 
relevant, the date the request was created, and the status of the request. 

NTD Process after e-File Submission 
Acknowledgment of Submission 

For most submissions, no acknowledgement is provided regarding receipt at the NTD project site. If you concerned about a 
submission, please contact your NTD validation analyst. 

However, acknowledgements are provided upon receipt of waiver requests, etc., at the NTD project site. An e-mail is sent 
back to the CEO and contact person acknowledging receipt of the correspondence. This acknowledgement is also posted on 

Add Waiver Type menu selection: 
 
Data Waiver 
Financial Statement Waiver (IAS–
FD) 
Reporting Waiver 
Passenger Mile Sampling Waiver 
Planning or Capital Grants Waiver 
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the e-File tab. If there are problems with the original request, you should contact your NTD validation analyst immediately 
upon receipt of the e-mail. 

Request Status 

Once a request is submitted, NTD begins processing the request or declaration. When the process is complete, it is given a 
final status that the transit agency is able to view. 

The status column is intended to inform the transit agency about the progress of each request. Distinct statuses apply to the 
different request types. The following is a list of the potential statuses and their meanings: 
• Not Submitted: The request is attached but was not submitted to the NTD. The request remains available to the transit 

agency for editing and saving but is not valid until submitted to NTD. 
• Received: The request was successfully submitted to NTD. NTD staff will review and take action, if appropriate, on the 

request. 
• Approved: The request was reviewed and approved by FTA. 
• Approved with Issues: Issues were found with the request but were not substantial enough to prevent FTA approval. 
• Denied: FTA denied the request. 

Viewing a Submitted Request 

Official notification from NTD is necessary for a request to be considered approved or denied. When such an action is taken 
by NTD, the status column will no longer appear as Received but will instead reflect the appropriate status. A status other 
than received indicates that NTD processed the request. Once the status changes, you can review NTD's official response. 

To view, click on the hyperlink for the submitted requests you want to view. There will be a link for the Letter Attachment 
(as there was when editing). However, since it was already submitted, you cannot edit the request and the Save and Submit 
buttons are no longer be available. 

When you access the e-File Summary screen, there may be two links for attached files. This occurs if you submitted an 
attached document to NTD. The submitted document will be the first link you see. The second link is the official response 
from NTD. To view the response, you should click on the link and select Open Document when prompted by the operating 
systems dialog box. 

e-File at the End of the Year 
At the end of the report year, the e-File Summary screen provides a picture of an entire report year. The number of requests 
will vary by transit agency; however, all correspondence between the transit agency and NTD is captured. Most important, 
when the transit agency is closed out, under Report Stage the status Closeout appears, and a closeout letter is listed. 

Communications Summary: Viewing a History of Correspondence with NTD 

 
 

The Communications tab gives transit agencies a centralized area in which to view their past correspondence with the FTA 
NTD program. In addition, the correspondence view can be filtered to show only certain processes or communication types.  
  

uyen.thai
Line
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Tips for Using Internet Reporting 

Navigating Between Screens 
You should not use the browser Back and Forward buttons to navigate between screens. Instead, you should use the 
Internet reporting system buttons, tabs and links.  

Saving a Form 
A Save button is provided at the bottom of each Internet reporting form. When entering information into a form, it is strongly 
recommended that you save the form frequently. This will prevent the loss of data if your Internet connection is unexpectedly 
lost. 

Also, Internet reporting has an automatic time-out feature which will log you off of the system after a period of inactivity. It is 
strongly recommended that you save your work every 15 minutes. Otherwise, there is a risk that the next action you take on 
the system will result in the closure of the screen displayed in your browser and the loss of any data that you had not saved. 

Viewing, Printing and Exporting Reports 
Reports can be generated within the Internet reporting system from either the Reports tab or from the individual form 
screens. 

Viewing a Report Online 
Click on the Report link on the Reports tab to display the report within the IE window. Use the scroll bar or the following 
navigation buttons to scroll through the report: 

• To go to the next page, use the right arrow   

• To go to the previous page use, the left arrow   

• To go to the last page, use the right arrow with a line to the right   

• To go back to the first page, use the left arrow with a line to the left.   

To Print a Report from the Reports Tab 
Click on the Print Report button  (printer icon) in the upper left corner of the viewer. A window will open; the document is 
converted to a PDF file; you then click the Print button on the resulting Print screen. 

To Print a Form Report from a Form Screen 

Click on the Print button at the bottom of the Form screen to display the report in the window. Click the Print button  in 
the upper left corner of the viewer. Then click the Okay button on the resulting Print window. 
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